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New Features & Improvements | Mobile

Security Questions

Security questions can now be viewed and edited in the Android and iOS apps. While in the app, users can tap
Login Details from the Settings menu item.

To see the previously-answered questions, users can tap Edit.
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By tapping the right-facing arrow, users are able to select new security questions.

eesco Verizon LTE 9:14 AM

Cancel Edit Login Details

. Barry Allen

LOGIN DETAILS

Usemame
flash&7
Gument Password

MNew Password

Confirm New Password

SECURITY QUESTIONS

Select 1st Question

What street did you live on in third grade?
a

Select 2nd Question

What is the strangest place you've ever been?

b

Select 3d Question

What was the last name of your third grade teacher?
c

Questions can only be used once

Users can also edit their Security Question answers by tapping the current answer to reveal the keyboard before
tapping Done. Users will then be be prompted to re-enter their password before they can save the new answer.

®eeco Verizon LTE 9:14 AM

Cancel Edit Login Details

LOGIN DETAILS

Mew Password

Confirm New Password

SECURITY QUESTIONS

Select 1st Question

What street did you live on iodiiird grade? b
Ve G |

Select 2nd Question

What is the strangest place you've ever been? 3

b
Select 3d Question

What was the last name of your third grade teacher?
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Posted Schedule Push Notifications

The following improvements have been made to push notifications regarding posted schedules:

o Store and Schedule names are now included
o Date and time of shifts are included
o The out time of a shift will only display if the Show Out Times permission is enabled.
o Notifications that are opened will take users directly to the appropriate week of the My Schedule
screen

Time Off Updates Push Notification

A new “Time Off Updates” push notification preference is now available for Android and iOS users with the
Request Time Off permission.

eec0 Verizon F 11:15 AM

< Preferences  Notifications

PUSH PREFERENCES

Schedule Change

Trade Decision

I Time Off Updates

EMAIL PREFERENCES

| @)
«©
Schedule Updates O
| @)
| @)

Shift Transactions
Approvals
Late Punches

BADGE PREFERENCES

New Message

The preference is OFF by default

Ea HOtSChEdu|e5" HotSchedules 4.0.56.1 Release Notes Page | 4



The notification will include the type of request being made, the manager's name who has made the decision to
approve or deny the request, the amount of paid hours (when available), the start date of the request, and what
the request decision was.

No SIM = a Unlocked @ 79% W)

/&

Tuesday, January 31

f=] HOTSCHEDULES now

Your time off request beginning on
Wednesday, 2/15/17 has been approved by
Johnny Lopez.

Slide for more

Press home to open

New Features & Improvements | Web

ASC - Preloads

Previously, there were two sub-tabs of Preloads within the Communication tab in the Above Store Console; one
was intended to upload and edit, while the other was to provide the number of views a Preload received at each
store it was assigned to.

Communication

Preloads Preload Control

Polls Preload Reads

Videos

Surveys

Status Activation Expiration Kame

Expirod 05/11/2016 05/11/2016 FarmFresh Burger L e
Saved 03/28/2016 03/30/2016 Tim Horton's Pre-Load o :_J [-]
Expired 04/01/2016  04/02/2016  Favorite New ftem t o))
Expired 11/19/2014 11/22/2014 Open Enroliment 0 (S
Expired 02/18/2036  02/19/2016  Dayight Savings = he
Expired 01/12/2016 01/12/2016 availability-Winter-2016  availability-Winter-2016 5 __-‘ [-]
Expired 0315/2015  0316/2015  LTO Chicken Taco o ne
Expired 08/01/2016 09/06/2016 ity test o (Y -]
Expired 06/13/2016 08/13/2016 Subway Preicad submeay sample 5 he
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Now that Preloads have been migrated to HTML, all actions can be done from one, much more intuitive area.
The main screen will display:

(1) - The name of the Preload
o (2) - The active date range of the Preload
o (3) - How many times the Preload displays for users
o A Preload with a Display Count of 0 will display for users until the expiration date, or until it is
manually deleted by an ASC user
o (4) - Whether or not the Preload is currently active
o (5) - More actions for the Preload including:

o The ability to copy an expired Preload to reuse
o The option to view how many times the Preload was viewed at each store it was assigned
o The ability to delete the Preload
o The option to manually end a currently-active Preload
Reports Communication Configure Logbook Forecasting PayControl Payroll Ranking Report ACA

Preloads

C— B ® ®

Name . ~ Start Date . ~ End Date ~  Display Count - Sttus -~ Actions

First Time User Preload Test Jun 7, 2016 Jun 10, 2016 0 Expired

Actions *
Jel 1 Jan 8, 2015 Jan 10, 2015 0 Expired | Copy
Login Workdlow 1 Jan 8, 2015 Jan 8, 2015 0 Expired View Results
Deleta
Moblle Test Dec 12, 2014 Dec 17, 2014 0 Expired
End Preload
Moble Test 2 Dec 12, 2014 Dec 16, 2014 0 Expired

By clicking Add Preload, users are presented with three tabs. The Setup tab is where users are required to name
the Preload, set the start and end dates for its run, and list the number of times they wish the Preload to display
for each user. As mentioned above, when the Display Count is set to 0, the Preload will display until its expiration
date, or until it is manually deleted by an ASC user.

Setup Design Reciplents

Name * Start Date * End Date *

Shoes for Crows 12/06/2016 ] a1o/eme

Display Count * {0 for unlimited)

o

Description
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The Design tab allows users to upload an image, type a message, and to use a variety of formatting options to
make their Preload look great.

Setup  Design  Recipients
File~ Edit~ Insert~ \iew~ Format~

|

il
[}
iii
i
il

N # Fomas B T E =

Selecting the “Recipients by" dropdown in the Recipients tab allows users to assign Preloads to:

O Everyone at a particular store
Users of a particular store and job
o Users of a particular store and permission
o Please note that a maximum of 5 permissions can be selected
o Users of a particular store and schedule

Setup Design Recipients
Recipients by
Store b
"1 New employees only
Stores.
~[l JLA Test Company
@ -l LA TST API Concept
#t JLA TST 005500
-8 JLA TST Area 1
#t JLA TST 001100
# JLA TST 002200
& # JLA TST 003300
[_) =@M JLA TST Area 3
("] #% JLA TST 004400
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ASC - Updated Schedule Status Report PDF

The PDF export of the Schedule Status report in the ASC has been updated to match the HTML and Excel

formats.

ASC - Actual vs. Scheduled Report Dates

Improvements have been made to the Actual vs. Scheduled Labor report so that the days displayed
more-accurately represent the work week of the store(s). For example, selecting to view a store whose week
starts on a Monday will display Monday as the first date in the report. When viewing two stores with two different
starting days to the week, the store's week with the closer day to Sunday will display. For example, if one store

has a Wednesday - Tuesday week, and another store has a Thursday - Wednesday week, the date range in the
report would display Wednesday - Tuesday.

Reports Communication Configure Logbook [Forecasting PayControl Payroll Ranking Report ACA

Actual Vs Scheduled Labor

Groups and Stores Displayed Woek Labor Units Type of Report Shifts

HS Grill - North Current Week - [0 / 30 7 2017 - 02/ 05/2007) - | Hours = | | Dally Summary - || AM * || Configuration - | ™1 | & | E Generate Repont
i | Tuesday Wednesday Thursday Friday |

Sched Actual Warlance Sched Actual Variance Sched Actual Variance Sched Actual Variance Sched Actusl

Admin 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Catering 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Dough/Prep 0.00 00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

Sites using the New Scheduler can now be configured so they are no longer restricted by their Day Parts when
submitting Time Off. This is helpful if an employee is able to work part of a morning shift, but not all of it. Now a
request is for the calendar day and not the business day. The feature works similarly to the current functionality

used in the Time Off & Requests sub-tab of the Home tab, however instead of selecting which Day Part an entry
will apply to, users can uncheck an All Day box.

Eg HotSchedules

Create Time Off or Request

e Earliest available day for most requests: Tue, Jan 10
Deadline to request this day: Mon, Jan 9 11:50 AM

Type Reason
| Unpaid Time off

@ Al Day: «

From Date:

4

2/6/17 5
To Date:
2/6/17 =

Comments (Required)

E Cance!

HotSchedules 4.0.56.1 Release Notes
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Unchecking the box allows users to click on the window to the right of each date to submit a start time to request
as well as an end time.

Create Time Off or Request x

@ Earliest available day for most requests: Tue, Jan 10
Deadline to request this day: Mon, Jan 9 11:50 AM

Type Reason
Unpaid Time Off - v

[T all Day:
From Date:
2/6/17 (% s:00m @O
To Date:
2/7/17 A - ~ ~

8 (oo M
Comments {Requin

v v v

= -

The "From" and "To" dates/times are required before being able to save. The Comments are only required when
a site requires a reason. (Please see the next feature write-up.)

Mobile users are able to submit an entry by time range as well. From the Time Off/Requests screen, users will

first need to select the type of request they want to submit. The All Day toggle will be set to ON by default, but
turning it OFF will allow users to select their start and end times to the request.

1:04 PM 2 3 s8c00 Verizon LTE 1:04 PM

Unpaid Time Off Cancel Unpaid Time Off

Earliest available day for most requests: Thu, 2/217

Earliest available day for most requests: Thu, 2217
Deadiline to request this day: Wed, 2117, 11:50 AM

Deadline to request this day: Wed, 21117, 11:50 AM

Type Unpaid Time Off Type Unpaid Time Off
A1l Day On * [ @) A1l Day Of * .
Starts a2n7 Starts Thu.-Fsb 2@ 12:15PM
Ends 20217 Ends Thu, Feb 2 @ 1:15PM
Comments (Required) Comments (Required)

Unpaid Time Off

Paid Time Off

Request to Work

Request Off

Cancel
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When reviewing the request in the Manage Time Off sub-tab of the Home tab, managers can tell whether a
request was submitted as a time range (1) or for an entire day (2).

Requested From ¥ Requested To

B
-
2/4/17 12:00 AM .

2/3/17 8:00 PM

2/4/17

2/4/17

Requiring a Comment for Time Off Requests

Sites can now be configured to require employees to submit a comment when submitting their Time Off and

Requests. From the employees' perspective, they will not be able to save an entry without first entering a
comment.

Create Time Off or Request x
@ Earliest available day for most requests: Wed, Pab 1
Deadline to request this day: Tue, Jan 31 11:50 AM
Type Reason
| Unpaid Time Off -
—| All Day:
From Date:
2/3/17 () s:00pm ®
To Date:
2/4/17 M 12200 ©
Comments (Required)
Sister's birthday part
“
Save Cancel
E)g HotSchedules HotSchedules 4.0.56.1 Release Notes
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Managers can then view the comments when approving/denying an entry.

Time Off - Barry Allen

Submitted: Mon, 1/30/17

Commants: Sister's birthday part «

Date Shift Approved

Fri, 2/3/17 Begins B:00 PM Total: O

Comments

Time Off on Behalf of Employees

With the necessary permissions, managers will have a Create Time Off button within the Manage Time Off
sub-tab of the Home tab where they can submit Time Off on behalf of their employees.

Create Time Off Time Off Approvals

Calenda
Qsearch Employees \ ,
Name + Schedules =

View All Employeas (1)
v Filter by Schedules Bobby Drake 2 Schedules © 7 Jobs &

[®) Blocked Days [ 3 Expand

+ Requested From * Requested To * Date Submitted -

11/30/16 8:00 AM 11/30/16 10:00 AM 11/29/16 11:26:26 AM
Busser (0)

Hast (0)
Kitchen (1)
Manager (0)
Wait Staff (1)

 Filter by Jobs

Busser (1)
Cook (1)
Host (1)
Manager (1)
Prep (1)
Server (1)

GJ)
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The Create Time Off or Request modal is where managers can make entries for their employees. When
submitting on behalf of their staff, managers can override cut off limits and blocked days. Furthermore, if the site
is configured for Paid Time Off, but an employee’s permission doesn't allow him/her to submit the time,
managers can do it on their behalf.

o (1) The Type dropdown allows managers to select what type of entry to enter (Unpaid Time Off, Paid
Time Off, Request Off, Request to Work)
o These options are directly related to the configuration of the site
o (2) Managers can use the Employee dropdown to select for whom the entry is intended
o (3) When Paid Time Off is being entered, the Comments dropdown allows managers to choose a
reason for the entry
o Thereasons are created in the Time Off sub-tab of the Configuration tab at the ASC level
o (4) When Paid Time Off is being entered, a Job must be selected from which those paid hours are
calculated from

Create Time Off or Request X

Earliest available day for most requests: Thu, Feb 2
Deadline to request this day: Wed, Feb 1 11:50 AM

Type . Reason .

| Paid Time Off v | | sick Time v |

Employee: . Job: .

| Barry Allen v | | cook

All Day:
From Date:

1/31/17 5
To Date:

1/31/17 )

Comments {Required)

Barry called and asked that I put this in for him |
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Upon saving a Paid Time Off entry, the modal for approving and denying entries will be displayed to allow
managers to select how many hours will be “paid hours” before approving the entry.

Time Off - Barry Allen X
Pending Approval
Submitted: Thu, 12/1/16
Comments: I need to see the dentist.
Date Shift Type Hours proved
- ; Breakfast 0
Sat, 12/3/16  All Day Paid Time Off ¥ 8 Afternoon 0
Evening 1]

Job: [ Busser 4 «

Comments [Remaining 128)

New Personal Settings
The Personal Settings page has been updated with a new look, and depending on permissions, will allow users
to upload a profile picture (1), edit their Preferred Name, Birthday, and Locale (2), submit Availability (3), edit their

Contact information and view Schedule and Job assignments (4).

_

-
@ Availability
® ==0
29 +
Barry Allen

Prafarred Nama 1a - 4edlp Unpvailable

©
2

All Day Unavailable

é :"_I_: All Day Unsvailable 1
. UR Al Day Unavailabie a
B cogonnses sies o) Contact Privacy Additional Info
v, (678) 3728781 Configure SMS f"’“"'“- :"H‘ .
N ® = o
Q address wa 5'-1 i;:;;n $10.00
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Time Range for Availability
One of the features of the new Personal page is the ability to submit an Availability by a range of time instead of
being restricted to Day Parts. This feature is only available to sites using the New Scheduler, and is dependent on
the calendar day and not the business day. The Personal sub-tab landing page will display the current
Availability.

Availability
= [
1AM 34 s 7o gur 110 1 k] s ™ 9 11
Mon Al Bay Unsvailable
Tue
Wed 18 - 4:45p Unavailabie
Thu
Fr Al Bay Unavallable
Sat | Al Day Unavailable
Sun Al Day Unavailable lﬁ

When enabled, the Employee Availability sub-tab of the Staff tab will be removed.

The current Availability will always be locked so users can't edit it, however they can submit a new Availability by
clicking the Add icon.

The dates indicate when the availability became effective.

Users are required to enter an “Effective” date for the new Availability. By leaving the Approving Manager
drop-down set to "Any," any manager with the Staff - Edit Employee permission will be able to approve the
submission. If users want to select a specific manager to approve, they will need to select the manager from the
drop-down.

It should be noted, however, that if they're going from any sort of limited availability to fully available, no manager

approval is needed. In these instances, managers with permissions to approve will receive a HotSchedules
Message indicating the employee is fully available now and that no other action is required.
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Additionally, users will have the option to provide a reason why the availability will be changing.

Availability
Effective: Approving Manager: Reason For Change:
MM/DD/YY Any N/A

Any white on the Availability grid will display when users are available, so when they are not available to work,
the slot will be in gray. To enter a time of unavailability, they can simply click and drag anywhere in the grid to
create the entry.

9a - 1p Unavailable

The time will move in increments of 15 minutes. If users make a mistake, they can hover the mouse on either side
of the entry until an arrow displays, and then click and drag to make their adjustment. Users might also find
situations where they attempt to drag an entire entry, but will end up creating 15-minute available slots within
their unavailable entry.

9a-10:! 10:30: 11 12
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To mark an entire day Unavailable, users can click on the day once, or twice to clear all entries for the day. To
wipe the grid clean and start from scratch, they can click the Clear Availability button at the bottom. When the
Availability is ready to submit, users can simply click Submit Availability at the bottom of the page.

Availability
=3
| 29 | 16 + |

Effective: Approving Manager: Reason For Change:

/16417 Any New School Schedule

1mm L 5a Fom L 11 am E L L T L 11w

‘ Clear Avallability
Privacy Additional Info

v, (678) 372-6781 Configure SMS Busse Busse
Cook

Contact

- owom .

B  kalel0a7@gmail.com

Q  ddress e
+1 More

Clty ST Zipcode

SUBMIT AVAILABILITY |=HE

One of the benefits of this new interface is the ability to have up to 4 availabilities submitted at any given time.
This allows employees to submit temporary Availabilities for things like Spring Break and school schedules.

Availability

Once 4 submissions have been made, the Add option will no longer display.
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When Availabilities have been approved, clicking any of the Availabilities will allow users to view what the
submitted Availability was for that effective date, and also allow them to delete it if necessary by clicking the X or
Delete Availability button.

Availability
| DEC | MARS,
16| [14] [21

3/14/17 Any Spring Break

1am 3 S ro G 11 1me E 5 7 L 11
Mon  All Day Unavailable
‘Tue All Day Unavailable
Wed Al Day Unavailable
fiu | All Day Unavailable

Fri  All Day Unavailable

Sat  All Day Unavailable
All Day Unavailable a

Delete Availability

Once an Availability is submitted and approved, it cannot be edited. Users will need to delete it, and create a
new one.

Managers who have the Staff - Edit Employee Availability permission will have the new Availability Approval
interface along with an updated sub-tab in their Home tab which will display badge notifications. When there are
Availabilities to approve, there will be a numbered badge icon on the sub-tab for every employee with a pending
Availability change.

Auto (Pickup/Release) Shift Approval Punch Record Approval History Manage Time Off Approve Images Availability Approvap

Upon clicking the sub-tab, managers will see the employees on the left who have Availabilities that need to be
approved. Employees are ordered by those with older requests at the top of the list, followed by employees with
the most recent requests at the bottom. In other words, those who have been waiting the longest for an approval
will be at the top of the list.

Ea HOtSChEdUlES" HotSchedules 4.0.56.1 Release Notes Page | 17



When selected, each of the employee's Availabilities will be displayed on the right. The current Availability, and
who it was approved by will be listed first, followed by the Availability that needs approval, and then each
Availability in order of their effective date. The gray bars in each grid is the employee's current Availability, and the
blue bars is the newly-submitted Availability. To view just the current availability, managers can select the expand
icon.

_

U, . - " [ AU —

I:b Current Availability

@ Barry Allen 29 " approves my: Gnger Grane

@ st T
16| Mansen Por Change: b School Echedule

When denying an Availability, managers can provide a reason why. The system does not require them to provide
a reason when they deny, but they still have to click Send to complete the denial. Each approval and denial will
be sent to the employee in the form of a HotSchedules Message. Additionally, when the employee logs into the
web, and navigates to his/her Personal settings, a similar message will display indicating the status of their
Availability request.

E Availability Starting 3/14/17

() DENY (+) APPROVE
Reason For Change: Spring Break _

1am 3 5am FaM 94 1144 1M NOTE:

LELE All Day Unavailable

You need to put in a Time Off request for

LU Al Day Unavailable this ‘

LB All Day Unavailable

Thu
All Day Unavailable | SEND
Fri

All Day Unavailable

Reguests Processed

'%29 Availability Approved
Sat ] Day Unavailable
ETLN All Day Unavailable Availability Approved

a Availability Denied

By:
Reason: You need to put in 2 Time OFf
request for this.

@ Availability Denied
By:

||

Please note there is no UNDO option when approving or denying.
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New Staff Profile Interface

Sites using the new Personal interface will also be configured to use a redesigned Staff Profile page for managers
who click on an employee's name in the Staff List. On the left, managers are able to edit personal information
such as phone number and email address. On the right, the Details tab (1) displays by default, followed by the
Jobs/Schedules tab (2), and then the Availability tab (3).

_
SuffUst Al Staff Certfications  Emplayee POS Adjezmens.
4= Back

JOBS [ SCHEDULES AVAILABILITY

DETAILS
Next shift
Barry Allen .

e a2

@ Uw SEND LOGIN

B woei0sr@gmailcom e SETTINGS
0 Account Btatus:
actve
..........
MESSAGE Parmission Sat:
Employee
Heal Break Rule:
Prefarred N J
© e e CERTIFICATIONS s
Flagh Expisation

-----
60 Day Employee Review
Birthday: 12348

wyn @ Alconol Cerufication = e
Hired Date:

o oM v a4
Liquor Card * Account Created:
v
Locale:

Enghish/united States (en-US)

The Details tab of an employee's profile is where managers can go for important information about the employee
such as when their next shift is and what certifications they have.

DETAILS JOBS / SCHEDULES AVAILABILITY

hif | |
m Mext sh 'f! SEND SCHEDULE ﬁ User | cenn oam
Th, 1/12/17 at 5:00 AM Rasghs

MESSAGE Permission Set:

CERTIFICATIONS M She/20, B 8he/15
60 Day Employes Review
@ Alcohol Certification * 118717

CPR* £ 254114

| Liquor Card * Account Created:
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The top section of this tab will display the employee's next shift and what his/her username is to access the
account.

DETAILS JOBS / SCHEDULES AVAILABILITY

Next shift User X
ﬁ Thu, 1/12/17 at 5:00 AM SEND $CHEDULE Flash&7 SEND LOGIN

For employees who have a confirmed email address, or have their text messaging configured, managers can
click the Send Schedule button to send a copy of any posted schedule. If an employee doesn't have his/her
email confirmed, the manager will be notified.

Unable to send login details X

Bobby does not have an email address listed.

OKAY

Managers can also send login details to users with a confirmed email or configured text messaging. By clicking
Send Login, they will have the option of sending just the username, or they can check the Include Password box
to send the employee a link so they can securely change their password.

Send Login Details X

Login details will be sent via employee's email and SMS text
addresses.

! Include Password (Sends user reset password link)

CANCEL SEND LOGIN DETAILS

While on the Details tab of the Staff Profile, managers can send a quick HotSchedules Message with the Message
tool.

We need waiters tonight. Please call the restaurant if you can help out. I'll comp a meal of your choice,

MESSAGE
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Managers can select from the certifications configured for their site to assign to employees. Enabling a new
certification will automatically display a date picker to configure the expiration date, but users can also click the
dates of previously-assigned certifications to enter a new expiration date.

CERTIFICATIONS
Expiration

60 Day Employee Review

Alcohol Certification * 1/18/17
CPR * 3/1/18
Liquor Card *

* Corporate Level Certification

The Settings panel is where various employee configurations can be made such as account status, permission
set, and hired date.

SETTINGS

Account Status:

Active

Permission Set:

Employee

Meal Break Rule:

M 5hr/20, B 4hr/15

HR ID:

12345

Hired Date:
244714

Account Created:

2/3/14

Locale:

English/United States (en-US)

Marked fields are editable by clicking the field and selecting an option.
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The Jobs/Schedules tab is where managers can assign jobs and schedules to their employees.

DETAILS JOBS / SCHEDULES AVAILABILITY
SCHEDULES Joss
3 0f 5 Selected v 6 of 6 Selected v
Busser Primary Skill Level () Hourly rate
Kitchen
Wait Staff Busser o1 v $5.00

i Cook o0 v $0.00
© Host 01 ~ $0.00
© Manager 01 v $0.00
© Prep 01 ~ $0.00
® Server o1 ~ $6.75

The Schedules pane will display the schedules that are assigned below a drop-down menu of all the schedules
available to assign. When collapsed, the menu will display the number of assigned schedules out of the total
number available.

SCHEDULES

3 of 5 Selected v

Busser
Kitchen
Wait Staff
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The Jobs pane will display the jobs that are assigned below a drop-down menu of all the jobs available to assign.
When collapsed, the menu will display the number assigned jobs out of the total number available.

JoBs
6 of 6 Selected w
Primary Skill Lavel () Hourly rate

0 Busser 01 ~ $5.00

0 Cook 01 e $0.00

0 Host 01 - £0.00

0 Manager 01 w $0.00

O Prep 01 hd $0.00

® Server 01 b £8.75

O Imported and new-employee accounts will not have a default Primary job, however selecting one
makes it easier and quicker to schedule newly created shifts in the Scheduler.

o The Skill Level for each job is an indication of the employee's ability for the specific job, and provides
more options when using the AutoScheduler tool.

0 Most sites integrate their jobs with a Point of Sale system, so the Hourly Rate for each job tends to
come from there.

With the Availability tab, managers can view the employee's Availability as well as submit a new Availability on
behalf of the employee. Submitting an Availability on behalf of an employee works the same as outlined in the
Time Range for Availability section above.

_

Staff List All Staff Certfications Employes POS 1D Pay Adjustments ACA Management
& Back

DETAILS JOBS / SCHEDULES AVAILABILITY

o) -

Barry Allen [20] [16] [ +

Effactive: Reason For Change:

. (er) 372-0701
A

B eoi067@gmain.com
e ET 5 7 9 11 A I s 7 o 11

MOn | Al Day Unavailable

.........
1a - 4:48p Unsvailable

Prafarred Name: ol All Day Unavailable

©llasl|

, Birthday:

Sat  All Day Unavallabia

Sun  All Day Unavailable

Clear Availability

= 1T
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Each time an employee's Availability is saved, the employee will receive a notification when they navigate to their
Personal settings that a new availability was approved.

Requests Processed

ﬁ Availability Approved

Employees will NOT receive an HS Message when a manager submits availability on their behalf.

Reports Affected by Time Range for Availability and Time Off

The following scenarios will occur when a customer uses Time Range for Availability:

0 The Availability Report will be removed
o The Availabilities option will be removed when configuring the Extended Schedule Report
o The Availabilities option will be removed when configuring the Weekly Roster Report

The following scenarios will occur when a customer uses Time Range for Time Off:

o The Approved Time Off and Employee Request Reports will be removed

o The Approved Time Off and Requests options will be removed when configuring the Extended
Schedule Report

o The Requests option will be removed when configuring the Weekly Roster Report

Please note that the reports listed above are under construction, so they will be back soon. In the meantime, the
information they contain can be found in the Employee Information Center in the Scheduler, or from the Time Off
Calendar tab within the Manage Time Off sub-tab.

New Scheduler - Update to the Create House Shift Modal

The 4.0.55.1 Release (12.22.2017) introduced the ability to easily create house shifts by clicking ALT+CTRL+H if on a
PC, or ALT*COMMAND-+H if on a Mac. Updates have been made to the Create House Shift modal so that only
assigned jobs and schedules will display to alleviate the risk of posting a house shift no one can pick up.

New Scheduler - Continued Removal of Locations
The 4.0.53.0 Release (09.15.2016) removed the Locations options from several areas of the Scheduler if a site did
not have any Locations configured. The option has now been removed from the AutoScheduler, the Roster
Report, and the SmartSelect tool.
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New Scheduler - Display Cost Setting
Managers now have the option to hide the cost in the Scheduler. The option is enabled by default, but to remove
it from displaying, they can navigate to the Scheduler Settings and uncheck the box.

Settings x
Display Settings: Alert Settings:
| Preferred Name Minar
Out Tim Availability
Cost Overtime
Schedule ACA
i Job
a Configuration Settings:
Location View Schedule By:
House Shift Manager First Name [
Schedule Summary Default shift length B | hours
Forecast Data Sort SmartSelect By:

Hours %
Labor Volume ¥

Full-Time Hourly: 0

New Scheduler - Forecasting Data

Improvements have been made to the forecasting data in the Scheduler to match the forecasting data on the
Forecast Projections page.

New Scheduler - Editing Day Notes
Day Notes in the Scheduler can how be edited by their creator, or deleted by any user with the permission to
create them. While viewing a Day Note, the creator of that note can hover the mouse over it to show the edit
pencil or delete icons in the upper, right-hand corner.

Memos x

Schedule Note | Message Staff

¢ Sat, 1/28/17 >

Chris §. Created : 1/27/17 at 2:29 PM * s ®
The Corporate Executive Chef, Kyle is bringing in scme potential investors

tonight. Let's make everything perfect!

Add Note Cancel
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Clicking the pencil icon will allow the creator of the note to make in-line changes that will save in real time, and
upon clicking outside of the text box, the timestamp label for the note will change from “Created” to “Edited” with
the updated date and time.

Memos X

Schedule Note | Message Staff

< Sat, 1/28/17 >

Chris s| Edited : 1/27/17 at 2:34 PM I

The Corporate Executive Chef, Kyle is bringing in some potential investors
tonight. Everyone needs to have their game faces on!

Add Note Cancel

Matching Forecasting and Proforma Reports

Improvements have been made to back-end calculations so that figures within the Forecasting tab will now
match the projections in the Labor Proforma Il reports.
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